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Inleiding
Deze handleiding is geschreven als onderdeel van het Meet Je Stad! Project van de 
Universiteit Amersfoort. In dit project worden effecten en ervaringen omtrent 
klimaatverandering in kaart gebracht.

Één van de manieren waarop dat gebeurt is door het meten van diverse klimaat-
gerelateerde waarden op verschillende plekken in de stad. Hiermee kunnen trends en 
verschillen binnen de stad in kaart gebracht worden.

Hiervoor is een meetstation ontworpen, dat door geïnteresseerden tijdens een 
workshop zelf in elkaar gezet kan worden. Deze handleiding is bedoeld om deze 
workshops te begeleiden.

Een meetstation bestaat uit 2 componenten:

• Een printplaat met sensors, aansturingselectronica en een zender. Deze 

printplaat verricht en verzendt de metingen.

• Een weerhut, om de printplaat en sensoren te beschermen en de invloed van 

zonlicht te minimaliseren.

In deze handleiding komen beide componenten aan bod.
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Solderen meetstation
Je krijgt een box met gereedschap. In deze box vind je alles wat je nodig hebt. Om te 
beginnen de soldeerbout, soldeertin en de kniptang. De multimeter en de programmer 
heb je later pas nodig, de desoldeerpomp alleen als je een foutje hebt gemaakt. 
Hieronder zie je de inhoud van de box.

Je krijgt ook een zakje componenten. Hieronder staan de namen van de componenten. 
De piezo wordt op dit moment nog niet gebruikt en ontbreekt mogelijk.
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Je begint met de printplaat (ook wel PCB, voor Printed Circuit Board, of gewoon 
printje). Hierop soldeer je straks al je componenten. Op het PCB staan teksten, zoals C1, 
R4 etc. Dit zijn unieke namen voor alle componenten en vertellen je welk componentje 
waar moet komen. Soms staat er ook nog de waarde of typenummer van de 
componenten bij, of andere verklarende teksten om het werk makkelijker te maken.

Begin met het aanzetten van je soldeerbout, deze moet eventjes opwarmen. Zet de 
soldeerbout niet te heet maar ook niet te koud. De
stand op de foto is een goede indicatie. 

De meeste componenten druk je vanaf de
bovenkant (de kant met de meeste tekst) met de
pootjes door het PCB heen en dan soldeer je ze
aan de onderkant vast aan het eilandje (zie foto).
Uitzonderingen zijn de transceiver, en
batterijhouder die onderop de print komt, maar
daar komen we straks op. 

Na elk componentje met lange pootjes dat je gesoldeerd hebt knip je de pootjes af. 
Houd hierbij het deel dat je afknipt goed vast zodat het niet in je oog of in dat van 
iemand anders springt.
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Volgorde opbouw meetplatform
In principe maakt het niet uit in welke volgorde je alle componenten vastsoldeert, maar 
de volgorde in deze handleiding zorgt ervoor dat componenten elkaar niet te veel in de 
weg gaan zitten tijdens het solderen. Op de volgende pagina's worden alle 
componenten één voor één behandeld, maar hieronder staat de volgorde alvast 
samengevat:

1) IC voet U1: DIP-28: let op orientatie!
2) connector JP1: 3 pins male header
3) connector P2: 6 pins male header
4) connector P3: 4 pins female header + 4pins male header
5) connector P4: 3 pins JST connector
6) weerstanden R3, R4, R5, R8: 1k
7) weerstanden R1, R2, R6, R7: 10k
8) optioneel voor regenmeter: R9 (10k), R10 (1k), P5 (2 pins female header)
9) optioneel voor lichtmeter: R11 (10k) en R12 (100k), P6 (2 pins female header)
10) optioneel voor bodemvocht: R13 (10k), P7 (2 pins female header)
11) condensatoren C1, C3, C5: 100nF
12) condensator C2: 100µF: let op orientatie!
13) condensator C4: 100µF: let op orientatie!
14) LED D1: let op orientatie!
15) FETs Q1 en Q2: STU60N3LH5: let op orientatie!
16) LDO U3: MCP1700: let op orientatie!
17) batterijhouder P1
18) transceiver U2: RFM95W: let op orientatie!
19) connector Reset: 2 pins male header
20) antenne AE1
21) Atmega328p microcontroller
22) Jumper voor power
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Begin met het IC-voetje (IC1). Dat heeft aan één van de smalle kanten een uitsparing. 
Dat is een merkje waar je later aan kunt zien hoe het IC er in gezet moet worden.
Op het PCB staat ook zo'n half rondje afgebeeld. Zet het IC-voetje er zo in dat de 
merkjes aan dezelfde kant staan.

Draai de PCB dan zo om dat het voetje niet weer uit de gaatjes valt. Aan de achterkant 
soldeer je alle pootjes vast aan een eilandje.
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De male pinheaders (JP1, P2) hebben een kant met lange pootjes en een kant met 
korte pootjes. Steek ze met de korte pootjes door de print en soldeer ze aan de 
achterkant vast. Let op dat je ze goed recht zet.

De female pinheader (P3) is het volgende componentje. Let op: deze komt aan de 
achterzijde van de print.

De JST connector (P4) gaat wat moeilijk in zijn gaatjes. Het is niet erg als er een halve 
millimeter afstand tot het PCB blijft. Let op dat je hem er goed om op zet, kijk hiervoor 
naar de foto.
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De 1 kΩ (kilo-ohm) weerstanden (R3, R4, R5, R8) gaan als volgende op het PCB. Op het
printje worden weerstanden met verschillende waarden gebruikt. De waarde van een 
weerstand kun je aflezen aan de kleurcode. De code voor 1kΩ is bruin-zwart-rood. De 
gouden rand zegt niets over de weerstandwaarde maar over de precisie van het 
componentje. Dat kun je in dit geval negeren. 
Steek de weerstanden door de print, het maakt niet uit hoe om. Aan de achterkant buig
je de pootjes een beetje naar buiten, dan blijft het componentje beter zitten tijdens het 
solderen. 

De 10kΩ weerstandjes (R1, R2, R6 en R7) zijn de volgende. De kleurcode voor 10kΩ is 
bruin-zwart-oranje.

Hierna soldeer je componenten voor de regenmeter: R9 (10kΩ), R10 (1kΩ) en op P5 
een 2 pins female pinheader en de lichtmeter: R11 (10kΩ) en R12 (100kΩ), met 
kleurcode bruin/zwart-geel) en op P6 ook een 2 pins female pinheader. Voor de 
bodemvochtmeter plaatse je de laatste 2 pins female pinheader op P7 en een 10kΩ 
weerstand op R13. 
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Nu zijn de 100 nanofarad condensatoren (C1, C3 en C5) aan de beurt. Dit zijn de kleine 
oranje bolletjes. Op de condensator staat meestal “104”, wat betekent 10x104 pF (dus 
100.000 pico-farad, dus 100 nanofarad). Hier maakt het niet uit hoe om je ze erop zet.

Bij de electrolitische condensatoren (C2, C4) maakt dat wel uit! Meestal als de 
orientatie van een component uitmaakt, staat er iets van een merkje op. Bij eenvoudige 
componenten is dat vaak een merkje bij de -. In dit geval zit er aan één kant van de 
condensator een witte streep met een aantal minnen erin. Die zet je op de print aan de 
kant met het witte vlakje. Op ons printje betekent een vierkant soldeereilandje 
trouwens dat daar de + komt. Dus dat zijn twee manieren om te zien hoe je deze 
condensatoren op de print moet zetten.
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Bij de LED (Light Emitting Diode, een soort lampje dus) op D1 maakt de orientatie ook 
weer uit. De plus-kant (anode) van een LED heeft een net iets langere pin. De min-kant 
(cathode) van een LED heeft een heel iets afgeplat randje. De plus-kant moet in het 
vierkante vakje.

Bij de MOSFETs (transistors) op Q1 en Q2 is de orientatie weer belangrijk. Zorg dat de 
metalen achterkant aan de goede kant zit, zoals op de foto.
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Bij de spanningsregelaar (U3, ook wel LDO,
voor low-dropout of linear regulator
genoemd) moet je de pootjes iets uit elkaar
buigen voordat je hem op de plek kunt zetten.
Dat betekent ook dat je hem niet heel dicht op
de print kunt solderen.
Let ook hier weer op de orientatie, de regelaar
heeft een ronde en een platte kant die ook op
de printplaat getekend is.
Dit is een goed moment om je soldeerwerk tot
zover even te (laten) controleren. Als straks de batterijhouder geplaatst wordt, kun je 
niet meer goed bij de meeste soldeerverbindingen.

De batterijhouder komt onderop de print. Aan de voorkant zie je een + en een – staan, 
de pootjes van de batterijhouder komen door die gaatjes.
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Nu je al wat meer gesoldeerd hebt kun je wat kwetsbaarder componentjes aan. De 
transceiver bevat veel hele kleine componentjes en ook dingen die niet goed tegen 
hitte kunnen. Die moet je dus niet al te lang solderen. 

De transceiver heeft geen pootjes die je door de print heen kunt steken. Je legt hem er 
gewoon op. Er is een trucje om de transceiver goed recht op de print te krijgen. Vertin 
eerst een enkel eilandje. Leg dan de transceiver op de print en druk hem aan terwijl je 
hem recht houdt. Zorg dat hij goed boven zijn eilandjes zit. Houd de soldeerbout kort 
tegen het gesoldeerde eilandje. Nu zit er een hoekje vast en kun je rustig de rest 
solderen. Let goed op dat je geen verbindingen maakt tussen verschillende eilandjes.
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De laatste onderdeeltjes die op de printplaat wordt vastgesoldeerd zijn de antenne en 
een laatste tweepins pinheader op de reset-plek in de rechter bovenhoek. De antenne 
is simpelweg een draadje. De lengte is afhankelijk van de frequentie van het radio-
signaal. Voor onze zender gebruiken we een draadje van 90mm, waarvan 3mm 
afgestript is voor het vastsolderen.

Nu komen we bij de sensoren. In het transparante zakje zit de temperatuur- en 
vochtsensor. Daar moet je de pinheader nog even op vast solderen. Die komt aan de 
onderkant van de sensor.

Nu kun je alle sensoren op de print aansluiten. De GPS-module steek je in de witte JST-
connector. De temperatuur- en vochtsensor komt op de 4-pins female pinheader (kijk 
even op de foto hoe om!).
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Het IC kan in het IC-voetje gestoken worden. Let er daarbij op dat het merkje weer op 
de goede plek zit. Soms moet je de pinnen van de IC iets naar binnen buigen. Dat kun je 
het beste doen door het IC op z'n kant te leggen op de tafel en het een beetje tegen de 
tafel te drukken. Kijk goed als je het IC in z'n voetje steekt of alle pinnen goed in de 
gaatjes vallen voordat je hem aandrukt.

Voordat je de batterijen er in doet kijk je even alle verbindingen na. Zijn er geen 
verbindingen tussen eilandjes ontstaan? Heb je alle componentjes goed om? Ziet het er 
net zo uit als op de foto? Ja? Dan kun je de batterijen er in doen.

Met de jumper bepaal je of het meestation aan of uit staan, en welke stroombron er 
wordt gebruikt. Een jumper is in feite een klein draadbruggetje: Je schuift hem over 2 
pinnen heen, en die 2 pinnen worden dan met elkaar verbonden. De bovenkant van de 
jumper is de kant met een ribbeltje voor je nagels en de uitsparing.

Om het meetstation aan te zetten, moet je de middelste pin van JP1 verbinden met 
ofwel de rechter, ofwel de linker pin. Op de “PROG” stand, zoals hieronder, gebruikt het 
meetstation stroom vanaf de programmeerverbinding (P2). Op de “BATT” stand 
gebruikt het meetstation stroom van de batterijen. Als de jumper geen verbinding 
maakt is het meetstation uit. Het handigste is om de jumper over de twee pinnen van 
de reset pin header te schuiven, zo krijgt de print geen voeding en raakt de jumper ook 
niet kwijt.

Als je wilt weten hoe de schakeling werkt, kun je hieronder verder lezen. Als je dat liever
later doet, kun je doorgaan naar het hoofdstuk “Programmeren microcontroller”.
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Hoe werkt de schakeling?
Het doel is een goedkoop en veelzijdig meetplatform dat in het veld een aantal 
maanden zelfstandig kan functioneren en sensordata draadloos naar een centrale 
database stuurt. Typisch zal een paar keer per uur een aantal waarden worden 
uitgelezen dat vervolgens als één klein pakketje wordt verstuurd. Om de schakeling zo 
lang mogelijk te laten werken op één batterijlading moet alles zo energiezuinig mogelijk
worden uitgevoerd.

Het schema bestaat uit een aantal delen met elk hun eigen functie. Het totale schema is
links afgebeeld, de afzonderlijke onderdelen worden hieronder behandeld.

De basis
Het hart van de schakeling wordt gevormd door de microprocessor U1 (AVR 
ATmega328p). Deze chip is ook de basis van de Arduino Uno, een veelgebruikt open 
source elektronica-ontwikkelplatform waarvoor een gebruiksvriendelijke 
programmeeromgeving bestaat. Zie ook het volgende hoofdstuk over programmeren. 
De chip heeft zo'n 20 pennen waarmee verschillende soorten signalen kunnen worden 
in- of uitgevoerd. C1 (100nF) is een ontkoppelcondensator die ervoor zorgt dat de chip 
een stabiele voedingsspanning houdt ook wanneer er plotselinge variaties zijn in het 
stroomverbruik of bij kleine verstoringen als gevolg van hoogfrequente signalen in de 
schakeling.

De schakeling wordt gevoed met 3.3V die wordt verkregen door de batterijspanning 
(die sterk kan varieren afhankelijk van hoe vol de batterij is) aan te bieden aan U3. Dit IC 
(MCP1700-3302) is een lineaire spanningsregulator met een ruststroom van 1.6 A die μ
een ingangsspanning van tussen 3.3V en 6.0 Volt terugregelt naar 3.3V (het 
daadwerkelijke minimum ligt waarschijnlijk tussen de 3.5V en 3.7V, maar dat is 
afhankelijk van allerlei factoren, zoals temperatuur, stroomverbruik en variatie tussen 
componenten). De flankerende condensatoren C2 (100µF), C3 (100nF) en C4 (100µF) 
helpen weer om de rimpelingen in de spanning op te vangen en de voedingslijnen te 
stabiliseren.

Met de jumper JP1 kan worden geselecteerd of de voeding wordt betrokken uit een 
eigen stroomvoorziening van de print (van een batterij of adaptervoeding) of via de 
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connector P2. Deze connector kan gebruikt worden om de print aan te sluiten op een 
computer en dient 3 functies. Ten eerste kan deze gebruikt worden om nieuwe 
software in de microcontroller te laden. Ten tweede kan tijdens normaal bedrijf via deze
verbinding met de chip worden gecommuniceerd. Tenslotte kan de schakeling zoals 
gezegd ook worden gevoed met deze connector. De weerstand R3 (1k) beschermt de 
processor tegen een te hoge stroom wanneer de seriele verbinding over P2 met een 
apparaat communiceert dat 5V voert i.p.v. 3.3V.

Een speciaal stukje software in de processor, de zogeheten bootloader, zorgt ervoor dat 
de RESET-lijn (pen 1) kan worden gebruikt om te schakelen tussen normaal bedrijf of 
programmeerstand. Voor een normaal bedrijf moet deze lijn HOOG zijn, ofwel 3.3V. 
Daarvoor zorgt de pullup weerstand R1 (10k). Wanneer deze lijn echter via C5 (100nF) 
kort omLAAG wordt getrokken (dus naar 0V) zal de processor opnieuw opstarten, en 
voor een korte periode open staan om een nieuw programma in te laden via de seriele 
verbinding.

De transistor Q1 (STU60N3LH5) beschermt de hele schakeling wanneer een 
aangesloten batterij of externe voeding verkeerd om wordt aangesloten. Hiervoor is een
N-kanaal MOSFET gekozen die bij geleiding een lage weerstand heeft (8.4mohm). 
Wanneer de voeding goed om is aangesloten krijgt de gate een positieve spanning 
aangeboden en zal de FET in geleiding komen waardoor het stroomcircuit wordt 
gesloten. Is de voeding verkeerd om aangesloten dan spert de FET en kan de schakeling
niet worden beschadigd.
De meetgegevens van de sensoren moeten uiteindelijk op een server kunnen worden 
verwerkt tot een actuele kaart. Er is daarom gekozen voor een LoRaWAN compatible 
transceiver-module. LoRaWAN is een transmissieprotocol dat werkt in een radioband 
met een relatief hoog doordringend vermogen, waardoor er met weinig zendvermogen 
een groter bereik wordt verkregen dan bijvoorbeeld met WiFi. De module U2 (HopeRF 
RFM95W) combineert een laag energieverbruik met een groot bereik voor een 
beperkte bandbreedte.

Sensoren
De schakeling is voorbereid om verschillende sensoren aan te kunnen sluiten. Voor 
temperatuur en luchtvochtigheid is de Si7021 van Silocon Labs geselecteerd. Deze low-
cost sensor werkt op 3.3V en heeft een slaapmodus waarin 0.06µA wordt verbruikt. 
Belangrijke eigenschap is dat de sensor tegen condens kan.
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Communicatie met de sensor verloopt via het I²C protocol, waarvoor twee speciale 
pennen op de microprocessor zijn gereserveerd. De zogenaamde “pullup” weerstanden 
R6 en R7 (beide 10k) trekken de twee lijnen (data en klok) standaard omHOOG. 
Aangezien deze sensor als moeilijk soldeerbaar SMD component wordt gefabriceerd is 
gekozen voor een breakout-board van Sparkfun.

Voor plaatsbepaling is de GPS-module GP-20U7 geselecteerd. Omdat deze geen aparte 
slaapmodus heeft is een aparte schakelbare massa gecreëerd m.b.v. de transistor Q2 
(STU60N3LH5) die vanuit de processor wordt geschakeld via weerstand R1 (1k). 
Wanneer de module niet gebruikt wordt kan op deze manier eenvoudigweg de voeding 
worden onderbroken. Om nu te voorkomen dat vervolgens de positieve 
voedingsspanning (3.3V) die nog wel blijft aangesloten via de datapin de ingang van de 
processor kan beschadigen is nog een extra weerstand R4 (1k) opgenomen.

Een eenvoudige regenmeter kan worden gemaakt met een piezo-element dat als 
contactmicrofoon druppels kan registreren die op een oppervlak vallen. De weerstand 
R9 (10k) voorkomt eventuele schade aan de processor bij grote spanningspieken, 
bijvoorbeeld wanneer er iets stevigers dan een waterdruppel op het piezo-element 
belandt.  Parallel aan het piezoelement is nog R10 (1k) opgenomen die de opgewekte 
energie verstookt.

Een eenvoudige lichtmeter wordt gevormd door een fotodiode (BPW34) met 
weerstand R11 (10k). De gevoeligheid van de meting hangt af van de gekozen weerstand.
Door een tweede weerstand R12 vanuit de processor aan te sluiten op de massa kan het
bereik worden aangepast.

Bodemvocht wordt gemeten m.b.v. twee elektroden die in de grond worden gestoken. 
De weerstand van de grond tussen deze elektroden is afhankelijk van de vochtigheid 
van de bodem. Deze grondweerstand wordt in serie met een bekende weerstand (R13) 
aangesloten op een bekend voltage (3.3V). De gemeten spanning op de verbinding 
tussen de twee weerstanden (A1) geeft nu een indicatie voor bodemvochtigheid.
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Programmeren microcontroller
De chip die het hart van de schakeling vomt is ook de basis van de Arduino Uno. Dit 
open source hardware-ontwikkelplatform wordt voor ontelbaar veel 
zelfbouwtoepassingen gebruikt. Op de website van Arduino zijn dan ook vele 
voorbeelden te vinden die kunnen worden nagevolgd. Ook is er een grote online 
community die de meest voorkomende vragen als eens heeft beantwoord, en nieuwe 
vragen doorgaans snel kan beantwoorden.
Om de microcontroller te programmeren,  heb je de Arduino IDE (Integrated 
Development Environment) en wat ondersteunende bestanden nodig. Op 
http://www.meetjestad.net/meten vind je deze bestanden, samen met instructies over 
hoe ze geinstalleerd moeten worden.

Nadat je alles hebt geïnstalleerd kun je vanuit de Arduino IDE de microcontroller 
programmeren. Probeer bijvoorbeeld eens onderstaand programma in te voeren, 
hiermee test je een aantal zaken van je meetstation (stroomvoorziening, 
microcontroller, communicatie met de PC, LED).

int ledPin = 21;

void setup() {
  Serial.begin(9600);
  Serial.println("Hallo meet je stad!");
  
  pinMode(ledPin, OUTPUT);
}

void loop() {
  digitalWrite(ledPin, !digitalRead(ledPin));
  delay(500);
}
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Om dit programma op het meetstation te zetten (te “uploaden”), gebruik je de (seriele) 
programmeerverbinding zoals op de foto.

Als de programmeerverbinding is aangesloten kun je de stroom-keuze-jumper op 
PROG zetten om het meetstation via de USB kabel te voeden, maar je kunt tijdens het 
programmeren ook voeden vanaf de batterijen met de BATT stand. Let wel op dat de 
jumper wel op 1 van die 2 standen staat, anders heeft het meetstation geen stroom.
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Selecteer dan in de Arduino IDE onder “Tools” → “Board” “MJS meetstation” en onder 
“Tools” → “Port” de poort van de programmeerverbinding. De makkelijkste manier 
hiervoor is om de USB stekker van de programmeerverbinding even los te trekken en 
te kijken welke poort er verdwijnt uit het menu.

Klik op “Sketch” → “Upload”.

Eerst wordt de sketch gecompileerd, daarna wordt het resultaat naar het meetstation 
geuploaden. Terwijl dat gebeurt gaat de led op de programmeerverbinding knipperen.

Klik op Serial Monitor (rechtsboven in de Arduino IDE). Controleer of in het scherm dat 
verschijnt de snelheid rechts onerin goed ingesteld staat op “9600 baud” en de tekst 
"Hallo meet je stad!" verschijnt...

Firmware programmeren
Na dit testprogramma is het tijd om de echte firmware, die de GPS en sensoren uitleest,
te uploaden naar de microcontroller. Je kunt hiervoor de “mjs_firmware” sketch 
openen via “File” → “Sketchbook” in de Arduino IDE en die sketch op dezelfde manier 
uploaden als de test-sketch hierboven.

Als de firmware erop staat, kun je via de seriele poort weer debuginformatie uitlezen, 
om te zien of alles goed aangesloten is. De firmware zal beginnen met het uitlezen van 
de GPS, en dat zal binnen meestal te lang duren (maar na enige tijd geeft ie dat op en 
gaat de firmware verder met verzenden).

Op http://www.meetjestad.net/data/sensors_recent.php kun je alle gegevens zien die 
er op de server binnen komen, als het verzenden lukt staat jouw station hier ook 
tussen.
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Hoe werkt het programma?
(nog in ontwikkeling)
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Weerhut bouwen

De behuizing van de sensor moet aan een aantal dingen voldoen. Hij moet makkelijk te 
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maken zijn, van materialen die goedkoop zijn en makkelijk te verkrijgen. Dat zijn de 
eisen die het mogelijk maken dat iedereen de behuizing kan maken. Voor het 
functioneren van het meetstation zijn er ook nog wat eisen. De behuizing moet de 
electronica tegen weer en wind beschermen, maar ook weer niet afschermen. De 
electronica moet droog blijven als het regent maar er moet wel een goede luchtstroom 
langs de sensoren zijn. Verder moet de behuizing niet opwarmen in de zon, zodat de 
echte luchttemperatuur gemeten kan worden.

De behuizing bestaat uit twee pvc rioleringsbuizen in elkaar. De laag tussen de twee 
buizen zorgt voor een beetje isolatie om de invloed van wisselende bewolking uit te 
middelen. Bovenop de rioleringsbuizen komt een grote dop die een eindje boven de 
buizen zit. Zo kan de lucht goed door de behuizing stromen. Het geheel schilderen we 
wit om te zorgen dat het niet opwarmt door directe zon.

Onderdelenlijst weerhut
1x Afsluitdeksel 110 mm
1x Buis 80 mm x 200 mm
1x Buis 60 mm x 200 mm
2x Kunststof afstandbusje 8 mm lang
2x Boutje M5 x 20 mm
4x Sluitring M5
2x Moer M5
2x Perspex plaatje
4x Boutje M3 x 10 mm
8x Sluitring nylon M3
4x Moer M3
1x PVC plaatje met uitsparing
3x Rubberen blindklinkmoer M4
3x Boutje M4 x 20 mm met punt

Bouwbeschrijving
Combineer eerst de twee PVC buizen tot één dubbelwandige buis m.b.v. de M5 boutjes, 
moeren en afstandbussen. De kant met de 3 gaatjes in de buitenbuis is de bovenkant. 
Bevestig daarbij het losse PVC plaatje met de uitsparing onder de onderste moer aan de
binnenzijde van de buis, met de inkeping naar boven gericht.
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P VC  afs luitdeksel 1 1 0 mm 

1 3 mm 

Boutje M 5 x 20 mm 
S luitring M 5 
Afstandbus je 8 mm 

Antenne S luitring M 5 
M oer M 5 

G P S 
P VC  buis  80 mm 

200 mm lang 

Boutje M 3 
2 x R ing 
nylon M 3 

P VC  buis  60 mm M oer M 3 
200 mm lang 

P rintplaat 

 O mgekeerd,  a ls  boven 

Idem als  boven 

1 3 mm 

P VC  plaatje met uitsparing waar het 
onderste perspex printhouderplaatje in valt

P rintplaat

P erspexplaatje

P erspexplaatje

G P S



Monteer vervolgens de twee perspex plaatjes op de printplaat m.b.v. de M3 boutjes, 
moeten en sluitringen. Aan de antennekant komt het plaatje bovenop de print te liggen 
waardoor de antenne opgesloten raakt tussen de printplaat en het perspex plaatje. Aan 
de sensorkant komt het perspex plaatje aan de onderkant (batterijzijde) van de print te 
zitten, met het rechthoekige gat om de print header voor de sensoren heen waardoor 
extra bescherming krijgt.

De GPS module kan nu door het rechthoekige gat aan de bovenzijde worden gestoken. 
Wanneer de print rechtop staat wijst de antenne van de PCB (het metalen vlakje) naar 
boven zodat deze optimaal zicht heeft op de GPS satellieten.

Als laatste kan nu het deksel worden gemonteerd. Daarvoor moeten eerst de drie 
rubberen blindklinkmoeren van buitenaf in het deksel worden geschoven. Daarna 
worden, eveneens van buitenaf, de 3 M4 moeren met punt in de blindklinkmoeren 
gedraaid. Door deze aan de binnenzijde van de het deksel vast te houden en de boutjes 
tijdens het schroeven van de buitenzijde goed aan te drukken zetten de 
blindklinkmoeren zich tenslotte goed vast.

Het deksel wordt nu op de buis geplaatst door eerst één van de puntige M4 boutjes op 
één van de gaatjes in de bovenkant van de buis te plaatsten, daarna een tweede. 
Vervolgens kan de buis een beetje worden ingedrukt waardoor het laatste gaatje 
vrijkomt om het deksel te sluiten.

Voor een goede werking moet de weerhut wit worden geverfd. Schilderadvies:
• Eerst goed dofschuren
• Dan met een witte of lichtgekleurde kunststofprimer voorschilderen of -spuiten
• Daarna helderwit afschilderen of -spuiten

Als laatste kun je de Meet je Stad sticker op de weerhut plakken en het nummer van de 
sensor erop schrijven (staat op de microcontroller). Nieuwsgierige voorbijgangers 
kunnen met de QR-code de website van Meet je Stad vinden en jouw weerstation ook 
gaan volgen.
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1 0 mm 

Z wart rubberen "blindklinkmoer" 
Boutje M 4 x 20 mm met punt R ubber uitwendig 8 mm 

S chroefdraad inwendig 4 mm 

D eksel 1 1 0 mm 

Buis  80 mm 

Buis  60 mm 

Idem als  boven  Idem als  boven 
1 20 graden 1 20 graden 
verschoven verschoven 

K oppelingsplaats  van binnen en 
buiten PVC  buis  met boutje 5 mm 
Z ie deta ils  op blad 1 

G aatje 2 mm waar boutje M 4 met punt in past (3 x 1 20 graden verschoven) 
8 mm uit 

G aatje Bovenkant van de  
bovenkant buitenste 80 mm buis

PVC  afs luitdeksel 1 1 0 mm



Einde
Is de soldeerbout uit en afgekoeld? Staat de multimeter uit? Berg dan alle 
gereedschappen weer op in de box.

Je kunt het meetstation thuis een goede plek geven. Het heeft de voorkeur om de 
weerhut op een plek in de schaduw te hangen, op circa 2 meter van de grond en niet 
direct boven begroeïng. Liefst ook niet te dicht op een muur. Zie ook: 
http://www.vwkweb.nl/index.php?page=Richtlijn_Algemeen

Vergeet niet om de jumper op de batterijstand te zetten zodat heet meetstation 
daadwerkelijk aan staat. De meetprint kan nu van onderaf in de weerhut worden 
geschoven en zo gedraaid dat het onderste perspex plaatje in de uitsparing in het PVC 
plaatje valt.

Heb je nog vragen, of vindt je het leuk om een bijdrage te leveren aan het project? Stuur
dan een mailtje naar meetgroep@meetjestad.net, of komt eens langs in onze Riot 
chatroom: https://riot.im/app/#/room/#meetjestad:matrix.org.
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